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1 Introduction to the Virtual Server Installation 
The deployment of the Model Tribal System (MTS) application has been simplified to include 
the use of a complete deployment Virtual Machine (VM).  This approach to the baseline 
configuration has greatly decreased the timeframe needed for initial deployment of the MTS and 
has reduced the potential number of configuration errors that can occur during configuration of 
the multiple applications that support the configured product.  

Please complete the appropriate checklist in the Appendices section in full.  Direct any questions 
you may have on the checklist or the VM implementation to the assigned support technician by 
email or by calling the assigned technician directly (contact names and addresses are included on 
the cover email).  

Both the technical support team and tribal agencies providing assistance with application testing 
have extensively tested this deployment.  The MTS Virtual Server Template is designed to 
support a standard virtual machine configuration of MTS, preconfigured for a specific 
deployment of a Linux Virtual Machine.   
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2 Overview 
As part of the implementation process for the MTS, this process identifies how to use the MTS 
Virtual Template to install an MTS Virtual Machine at your local site, using VMware products. * 

For a Linux environment, the process can be completed using VMware Hypervisor and the 
vSphere v4.1 product.  For a Windows environment, the VM process can be completed using the 
VMware Player v5.  This document provides instructions for both processes.  Section 3 provides 
instructions for using VMware vSphere with Linux, and Section 4 provides instructions for using 
VMware Player with Windows.  A checklist format for each set of instructions is included in 
Appendices. 

*More information is available on the VMware website for VMware products, including 
VMware Hypervisor for Linux and VMware Player for Windows.  For use with Linux, the 
VMware website identifies the vSphere Hypervisor as “the free edition of VMware vSphere.  It is 
based on ESXi, VMware's next-generation hypervisor architecture.”  The website identifies a 
number of resources for more information on VMware Hypervisor, including a blog post on 
“Introducing VMware Sphere Hypervisor 4.1 – the free edition of VMware vSphere 4.1.”  See 
more information at:  

http://communities.vmware.com/community/vmtn/server/vsphere/hypervisor 

For use with Windows, the VMware website identifies the VMware Player as free for personal 
use, or as a component of the commercial VMware Fusion Professional. The website identifies a 
number of resources for more information on VMware Player, including technical and user 
documentation such as Getting Started with VMware Player.”  See more information at   

http://www.vmware.com/download/player/download.html 

  

http://communities.vmware.com/community/vmtn/server/vsphere/hypervisor
http://www.vmware.com/download/player/download.html
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3 Scope 
The MTS Virtual Template is an Open Virtual Archive (OVA) file that you import/deploy using 
the Open Virtualization Format (OVF) support of VMWare.  The MTS OVA file contains all 
components necessary for a complete MTS installation.* 

The MTS Virtual Template name is in the format of: 

TribeName_FIPS_ID_DATE.ova   

Component Name:  MTS Application File 

Number of Virtual CPUs: 2 

Amount of RAM:  4GB 

Hard disks:  16 GB 

* Open Virtualization Format (OVF) is a folder containing a collection of items required to 
complete the installation of a virtual machine, including a description file (.ovf), a manifest file 
(.mf) and virtual machine state files (.vhd or .vmdk).  An Open Virtual Archive (OVA) file is a 
single file that is a zipped version of the OVF folder, and includes the basic files from the OVF in 
the correct order for use.  Consider the OVA as a container and the OVF is a folder. 
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4 Instructions to Use vSphere to Install an MTS VM for Linux 
Installing an MTS VM is a three-part process, as outlined below.  These instructions are repeated 
in checklist format as Appendix 1 of this document if you wish to document your progress 
through the steps.   The instructions assume that you have already downloaded vSphere v4.1 or 
later, the VMware client for use with Linux operating systems. 

A. Import the OVA file using vSphere Client 
1. Locate the OVA file.   

• If you have elected to download the file, and have not already done so, download the OVA 
file from the VPN Portal directory identified by MTS technical support  

• If you have elected to download the file from the internet, have the URL at hand as provided 
by MTS technical support  

2. Open and login to the vSphere Client.  The display includes a main menu at the top of the 
screen (File, Edit, View, Inventory, Administration, Plug-ins, Help). 

 

 
 

3. Select File on the main menu to drop-down the File menu.  

 
 
Note that vSphere documentation uses term ‘deployment’ for activities you may be more familiar 
with as ‘import’ actions, i.e., the list item for Deploy OVF Template starts the action to import 
the OVA file. 
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4. Select Deploy OVF Template.... to open the Deploy OVF Template dialog. 

5. Browse to and click on the OVA file on your local system.  

6. The OVF Template Details screen opens and displays the selected OVA template name.  
Click [Next]. 

7. The Name and Location dialog opens for you to provide a new name and location for the 
MTS virtual machine in your environment.   

8. Enter a new name of your choice for the MTS virtual machine at your local site.  

 

 
 

9. Clicking [Next] opens the Datastore dialog box for you to select the drive on which to 
deploy the MTS template. 

10. The Datastore list displays the hard drives available on your server.  Select the hard drive on 
which to deploy MTS template. 
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11. Clicking [Next] opens the Disk Format dialog.   

12. For Disk Format, select the thin or thick provisioning option in use at your site. 

 

 
 
13. Clicking [Next] opens the Network Mapping dialog, listing the networks available on your 

site. 

14. On Network Mapping, highlight to select the correct network for the MTS VM deployment. 
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. 
 
 
15. Clicking [Next] opens the Ready to Complete dialog box, displaying the deployment settings 

you have selected.  Review the settings and note if and where changes are necessary.  

16. Click the [Back] button to return to any of the prior settings dialogs and change settings. 

17. Click [Finish] when settings are complete. 

18. An installation monitor pops up to display progress on installation of the MTS Virtual 
Machine.  Do not close or turn off your machine until the installation is complete. 

 

 

 
 
 
19. Clicking [Close] when the install process is complete returns the display to the vSphere main 

screen. 

At this point, the MTS Virtual Machine settings should be reviewed and configured. 
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B. Edit the Virtual Machine settings using vSphere 
1. On the vSphere main display, highlight the server on which you deployed the new MTS 

virtual machine to open the list of virtual machines that exist on the server.  The new MTS 
virtual machine should display on that list.   

2. Highlight and right click on the name of the new MTS virtual machine to display a menu of 
actions to take on that specific virtual machine.  The Edit Settings option will allow you to 
review and edit settings for conformance with your site, prior to powering up the new VM. 

 

 
 

3. Select Edit Settings to open the Virtual Machine Properties dialog.  Review the default 
settings for hardware, configuration options, and resources, and make any changes required 
by your site. 

4. When the Virtual Machine Properties dialog opens, the Hardware tab is already open.  The 
Hardware tab allows you to change hardware properties such as size of memory, size of 
drive, number of processors, by making changes directly to the screen display, as shown in 
the illustration below.   
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5. Review and correct configuration settings:  Click into the Options tab. 

6. Click on the General link in the item list. 

 

 
 

7. Click the Configuration Parameters button in the panel on the right. 

8. The Configuration Parameters dialog opens so that you can verify and correct the parameters 
as needed. 
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9. To add a configuration parameter, click on [Add Row] button below the configuration 
parameters to add a row. 

 

 
 
10. To modify an existing parameter, click on the parameter row, and modify the existing value. 

11. Example:  To add or modify a value for keyboard typematic rate: 

To add a value, click on [Add Row] button below the configuration parameters to add a 
row. 

To modify the value, click into the existing row. 

Enter or modify a new Name and Value as follows: 

Name: keyboard.typematicMinDelay  

Value: 1000000 

Click [OK] to save the row. 

12. When you are done reviewing or updating configuration parameters, click [OK] to save the 
settings changes. 

13. Review and correct settings under Resources as needed. 

14. Click [OK] to save all settings and return to the main vSphere screen. 

At this point, you are ready to review and validate the network settings for the MTS VM. 



Virtual Server Installation Manual 
 

Version 1.8 04/08/2014 14 
 

C. Review network settings 
Network settings have been configured from data in your MTS Setup Worksheet.  Please review 
the settings to ensure they are accurate for your site. 
 
1. On the vSphere main display, highlight the server on which you deployed the new MTS 

virtual machine to open the list of virtual machines that exist on the server.  The new MTS 
virtual machine should display on that list.   

2. Highlight and right click on the name of the new MTS virtual machine to display a menu of 
actions to take on that specific virtual machine.  To review and validate network settings, you 
will need to power up the MTS VM.  

3. Highlighting the Power option opens the submenu from which you power on, power off, 
suspend, or reset your MTS VM.   

 

 
 

Clicking Power On will power on the MTS VM and close the VM actions submenu.   

4. Highlight the MTS VM once more and right click to display the actions submenu, and click 
Open Console.  

5. Clicking Open Console starts an openSUSE session and displays a console view.  The 
console view displays a login prompt in the format:  

(local_server_prompt) login: 
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6.  Login.  It is important that you make an initial login to the Linux environment as soon as 

your MTS VM powers up for the first time to validate the username and password provided 
with your MTS VM deployment.  

• If your login is not successful, contact MTS technical support to validate the supervisor 
user ID and password. 

• If your login is successful, you are ready to verify settings. 

7. Power up the open-source graphical user interface (GUI) provided with the MTS 
deployment: at the login prompt, enter “startx.” 

 (Local_server_prompt): startx 
The GUI displays as shown below. 
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8. Use the Start icon at the lower left of the screen to open the openSUSE computer 
configuration window. 
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9. YaST* is the configuration toolset provided with the MTS VM.  Clicking YaST 
Administrator Settings opens YaST Control Center functionality for the environment.   

Click on Network Devices to open the Network Devices panel.   
 

 
 
*As noted on the openSUSE website, “YaST … is the installation and configuration tool for 
openSUSE ... distributions….YaST actually stands for Yet another Setup Tool.”   

YaST can be used to configure hardware, network, system services and security settings. 
More information on YaST and the YaST Control Center is available from the website: 
http://en.opensuse.org/Portal:YaST 

10. Click on Network Settings to open the Network Settings module.  If Overview is not already 
selected, click on Overview to see a list of the IP Addresses configured from your MTS Setup 
Worksheet.  Review and verify each IP address.  

 

http://en.opensuse.org/Portal:YaST
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11.  If an IP Address needs to be changed, highlight and click on the IP Address to open the 

Network Card Setup screen.  

 

 
 
12. Click [Next] to return to the Network Settings screen when IP addresses have been verified or 

corrected.  
13. Review settings under Global Options, HostnameDNS, and Routing tabs.  When settings are 

accurate, click [OK] to close the Network Settings screen. 
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14.  At this point, your MTS Virtual Machine is ready for the MTS application.   

RESTART YOUR COMPUTER to finalize and refresh settings.  

15. When restart is complete, you will be at the Login prompt.  

 

 
 
16. Create a browser shortcut or key in the IP address for the MTS application and verify that 

MTS comes up and presents a login screen.  
17. Login to MTS as a setup user to verify that the application is functioning properly. 
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5 Instructions for Using VMware Player to Install MTS VM for 
Windows 

 
Installing an MTS VM is a three-part process, as outlined below.These instructions are repeated 
in checklist format as Appendix 2 of this document if you wish to document your progress 
through the steps.  The instructions assume that you have already downloaded VMware Player 
v5.0 or later, the VMware client for use with Windows operating systems. 

A. Import the OVA file using VMware Player 
1. Locate the OVA file.   

• If you have elected to download the file and have not already done so, download the 
OVA file from the VPN Portal directory identified by MTS technical support  

• If you have elected to download the file from the internet, have the URL at hand as 
provided by MTS technical support 

2. Open VMware Player.  To start Player on a Windows host system, select  
Start > Programs > VMware Player.  

3. When you start Player, the Player window opens in the Home display. 

 

 
 

The screen is divided into three parts.  At the top of the display, the Player tab drops down a 
menu to change Player preferences or perform actions such as Power (Suspend / Power On), 
Full Screen, etc. 
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The left side of the screen displays a menu that includes a Home icon and a library list of 
existing virtual machines.  

• Clicking the Home icon from any screen returns to this screen  

• Clicking on an existing virtual machine will change the display on the right panel to a 
summary view of the selected machine, from which you can start the machine or view and 
edit machine settings 

On the Home tab, the right side of the screen on entry displays the Welcome panel with a 
menu of main functions including creating a new virtual machine, opening an existing virtual 
machine, downloading a new virtual appliance for an existing workstation, or viewing Player 
Help.   

 
4. To import the OVA file, click on Open a Virtual Machine to open a file location dialog 

window. 

 

   
 

Navigate to the location of the OVA file.  Highlight the filename and click the Open button at 
lower right. 
 

5. The Store the new Virtual Machine popup opens.  The current name for the OVA file 
displays in the Name entry box.  Change the name to the name that the virtual machine is to 
have on your system: 
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6. Click into the Storage path data entry area and enter or Browse to the new location for the 

virtual machine in your environment. 

 

 
 
 
7. Clicking Import opens the Player installer popup and begins installing the VM in your 

environment.  Player performs compliance and conformance checks for OVF and hardware 
specifications before beginning the installation.  If the import fails, click Retry to restart the 
process, or Cancel the import altogether.  Once the import begins, the installer displays a 
dynamic status of “Importing (your VM) …” from the OVA template.   

8. Player creates a set of files on the host system for each specific virtual machine, storing them 
in either the default virtual machine directory or the working directory.  For more 
information on the .vmx, .log, .vmdk, .vmem, .vmsd, .vmsn, and .vmss files created, see 
documentation on the VMware website. 

9. When the import is complete and the VM has been created, the progress popup closes and the 
Welcome to VMware Player screen opens.  The new virtual machine now appears in the 
library of available virtual machines. 
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Clicking on a powered-off virtual machine in the library opens a summary view of the 
machine in the right panel.   

10. Clicking on the MTS_Virtual_Machine opens the summary view shown below. 

 

 
 

The summary view shows high-level configuration information:  Current operating state, 
operating system in use (SUSE is provided with the MTS VM), VMware version in use, and 
RAM assigned to the virtual machine. 

Please review the hardware and memory settings before powering on the MTS VM.  

After the virtual machine settings have been configured for MTS, clicking Play virtual machine 
will power up the machine (power up the VM, start the SUSE operating system, load MTS for 
login), and display a console view for the VM. 
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Clicking Edit virtual machine settings opens the configuration module to edit machine settings.   

B. Edit the Virtual Machine settings using VMware Player 
1. Right click on the MTS VM and select Edit Settings. Note:  Any changes to settings must be 

made and saved before the machine is powered up. 

2. The Virtual Machine Settings dialog opens.  Hardware modifications, options, and resources 
can be modified directly on this screen.  Please review the default settings and make changes 
required by your site, such as increasing the amount of memory. 

 

 
 
 
3. When settings are complete, clicking [OK] will return to the Summary screen. 

 

C. Review network settings 
Before you begin using MTS, you should first test the logon username/password for the Linux 
environment, and then review the network settings for conformance with your environment.  
 



Virtual Server Installation Manual 
 

Version 1.8 04/08/2014 25 
 

1. At the Summary screen for the MTS virtual machine, click Play Virtual Machine to power up 
the VM, start the SUSE operating system, load MTS, and display a console view of the 
Linux environment.  

2. The console view displays a login prompt in the format:  

(local_server_prompt) login: 
 

 
 
3.  Login.  It is important that you make an initial login to the Linux environment as soon as 

your MTS VM powers up for the first time to validate the username and password provided 
with your MTS VM deployment.  

• If your login is not successful, contact MTS technical support to validate the supervisor 
user ID and password 

• If your login is successful, you are ready to verify settings 

4. Power up the open-source graphical user interface (GUI) provided with the MTS 
deployment: at the login prompt, enter “startx.” 

 (Local_server_prompt): startx 
The GUI displays as shown below. 
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5. Use the START icon at lower left of the screen to open the openSUSE computer 
configuration window. 

 

 
 

6. YaST* is the configuration toolset provided with the MTS VM.  Clicking YaST 
Administrator Settings opens YaST Control Center functionality for the environment.   
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Click on Network Devices to open the Network Devices panel.   
 

 
 

*As noted on the openSUSE website, “YaST … is the installation and configuration tool for 
openSUSE ... distributions….YaST actually stands for Yet another Setup Tool.”   

YaST can be used to configure hardware, network, system services and security settings. 
More information on YaST and the YaST Control Center is available from the website: 
http://en.opensuse.org/Portal:YaST 

7. Click on Network Settings to open the Network Settings module.  If Overview is not already 
selected, click on Overview to see a list of the IP Addresses configured from your MTS Setup 
Worksheet.  Review and verify each IP address.  

 

http://en.opensuse.org/Portal:YaST
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8. If an IP Address needs to be changed, highlight and click on the IP Address to open the 

Network Card Setup screen.  

 

 
 
 
9. Click [Next] to return to the Network Settings screen when IP addresses have been verified or 

corrected.  

10. Review settings under Global Options, HostnameDNS, and Routing tabs.  When settings are 
accurate, click [OK] to close the Network Settings screen. 
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11.  At this point, your MTS Virtual Machine is ready for the MTS application.   

RESTART YOUR COMPUTER to finalize and refresh settings.  

12. When restart is complete, you will be at the Login prompt.  

 

 
 
13. Create a browser shortcut or key in the IP address for the MTS application and verify that 

MTS comes up and presents a login screen.  

14. Login to MTS as a setup user to verify that the application is functioning properly. 

.  
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6  Appendices -- MTS VM Installation Checklists 

6.1 Appendix 1 -- MTS VM Installation Checklist for Linux using vSphere 

A Import the OVA file using vSphere Client Complete 

1 Locate the OVA file.   
• Download the OVA file from the MTS VPN Portal directory, or  
• Download the file from the internet, using the URL  provided 

 

2 Open and login to the vSphere Client.  
3 Select File > Deploy OVF Template....  
4 Browse to and select the OVA file on your local system.  
4 Click [Next] at the OV Template Details screen  

5 Enter name for MTS VM in Name entry area and click [Next].  
6 At Datastore, identify hard drive to load MTS template and click [Next].  
7 At Disk Format, select thin or thick provisioning and click [Next].  
8 At Network Mapping, select the correct network and click [Next].  
9 At Ready to Complete, verify deployment settings and click [Finish].   
10 Close Installer when installation is complete.  
B Edit the Virtual Machine settings using vSphere  

1 From vSphere main menu, select the server and new MTS virtual machine.   
 Right click on MTS virtual machine and select Edit Settings.  
2 Verify or correct settings under Virtual Machine Properties 

• Hardware 
• Options 
• Resources 

 

C Review network settings  

1 From vSphere main menu, select the server and right click the new MTS virtual 
machine to open the actions menu.  

 

2 Select Power and then click Power On to power up the MTS VM.    
3 Reselect the server and right click the MTS VM to open the actions menu  
4 Click Open Console to open a SUSE session and console view  
5 Login to the Linux environment to validate the supervisor logon credentials  
6 Power up the GUI. At the login  prompt, enter startx  
7 Mouse over START icon to open computer configuration window  
8 Click YaST Administrator Settings to open YaST Control Center  
9 Click on Network Settings and Overview to validate IP Addresses  
10 Review settings under: 

• Global Options 
• HostnameDNS 
• Routing 

 

11 Click [OK] when settings are validated.  
12 Restart computer  
13 Key in or create browser shortcut to IP address for MTS application  
14 Verify that MTS login screen appears  
15 Login to MTS as setup user to verify that MTS is functional.  
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6.2 Appendix 2 -- MTS VM Installation Checklist for Windows using VMPlayer 

A Import the OVA file using VMware Player Complete 

1 Locate the OVA file.   
• Download the OVA file from the MTS VPN Portal directory, or  
• Download the file from the internet, using the URL  provided 

 

2 Open and login to VMware Player.  
4 Select Open a Virtual Machine.    
5 Navigate to and highlight the OVA filename, and click Open.  
 In Store the new Virtual Machine: 

• click into Name and create new name for MTS VM 
• click into Storage path and enter or browse to new location for MTS VM 

 

6 Click Import to open installer popup.  
 On Welcome to VMware Player, highlighting and clicking the name of the new 

MTS VM opens the MTS VM summary view to Edit settings 
 

B Edit the Virtual Machine settings using VMware Player  

 On the MTS VM summary screen, click on Edit Settings  
 Review and validate settings for: 

• Hardware (devices and memory) 
• Options 

 

C Review network settings  

1 At the Summary screen for MTS VM, click Play Virtual Machine to power up the 
VM and open a SUSE session with a console view. 

 

2 Login to the Linux environment to validate the supervisor logon credentials  
3 Power up the GUI. At the login  prompt, enter startx  
4 Mouse over START icon to open computer configuration window.  
5 Click YaST Administrator Settings to open YaST Control Center.  
6 Click on Network Settings and Overview to validate IP Addresses.  
7 Review settings under: 

• Global Options 
• HostnameDNS 
• Routing 

 

8 Click [OK] when settings are validated.  
9 Restart computer  
10 Key in or create browser shortcut to IP address for MTS application  
11 Verify that MTS login screen appears  
12 Login to MTS as setup user to verify that MTS is functional.  
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